
уществует мнение, будто коррекция в LAB — это нечто похожее

на ракетные технологии: вещь в себе, требующая длительного

изучения, сложная для восприятия и таящая в себе потенциаль-

ную угрозу взрыва.

Но это не совсем так. Многие вещи в LAB делать проще, удобнее и эф-

фективнее, чем в CMYK и RGB. Даже те ретушеры, которые чувствуют се-

бя в этом пространстве весьма неуверенно, нередко обращаются к нему

для размытия или повышения резкости изображений. LAB активно про-

никает в наш рабочий процесс не потому, что напоминает ракетную техно-

логию, а потому, что облегчает нам жизнь. Фотографию на рис. 5.1 предо-

ставили мои друзья из Космического центра имени Джонсона в NASA, и

на ней изображен ученый, занимающийся самыми настоящими ракетны-

ми технологиями.

Фотографии, снятые в неблагоприятных условиях освещения, всегда пол-

ны шумов. Но шумы на фотопленке по сравнению с шумами цифровых

снимков — это все равно что аэроплан братьев Райт по сравнению с косми-

ческим кораблем «Галилео». Похоже, производители фотокамер держат осо-

бые команды технических специалистов, главной задачей которых является

разработка все новых и новых способов заполнения синего канала случай-

ными пикселами. Порою они чуть ли не полностью вытесняют пикселы са-

Повышаем резкость в L,
размываем АВ

Фокус формируется за счет вариаций светлоты и не зависит от цвета. Шум в

большинстве случаев связан только с цветом и мало зависит от светлоты.

Благодаря раздельным каналам цвета и контраста, LAB предлагает наиболее

эффективный способ устранения шумов, а часто и наилучший способ

повышения резкости изображения.
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мого изображения, как это хорошо вид-

но на увеличенном фрагменте предыду-

щей фотографии (рис. 5.2А).

Такой же мусор, называемый по-на-

учному шумом, присутствует здесь не

только в синем, но и в более важном

красном канале. В подобных случаях

ретушеры обычно обращаются к како-

му-либо из многочисленных фильтров

размытия в Photoshop, каждый из кото-

рых способен нивелировать шумы в лю-

бом канале RGB или CMYK, а заодно и

убить там контраст.

В наш космический век для устране-

ния цветового шума пора бы исполь-

зовать более передовой метод, осно-

ванный на переводе изображения в

цветовое пространство, где цвет и кон-

траст содержатся в разных местах. Канал

В, управляющий оппозитным сине-жел-

тым компонентом, содержит наиболь-

шее количество шумов, хотя, как видно

из примера на рис. 5.3, в пурпурно-зеле-

ном канале А их тоже предостаточно.

Шумы здесь настолько заполонили

все изображение, что я не могу ис-

пользовать довольно мощный

фильтр Gaussian Blur без риска

разрушить все цветовые пере-

ходы. Вместо этого я восполь-

зовался фильтром Dust &

Scratches с непомерным радиу-

сом 7 пикселов в канале В и

4 пиксела в канале А.

Это подействовало. Отделив

таким образом ступень шума

от спускаемого аппарата изоб-

ражения, я снова вернулся в

атмосферу RGB. Теперь синий

канал на рис. 5.2В выглядит

прямо-таки кристально чет-

ким по сравнению со своим

предшественником.

Вторая ступень —
повышение резкости

Размытие, смешение или даже

ретушь каналов А и В прекрасно

устраняют шумы различного

происхождения и являются луч-

шим оружием против растриро-

ванных оригиналов, которые в

конечном итоге представляют
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Рис. 5.1. Пульт управления в Космиче-
ском центре им. Джонсона. Возможно,
именно такое освещение и нужно для ра-
боты операторов, но для цифровых ка-
мер оно создает проблемы, поэтому фо-
тография полна цветовых шумов.



собой экстремальный вариант того,

что мы видели на рис. 5.1.

Сразу хочу внести ясность.

Многие пользователи начинают

нервничать из-за любых шумов.

Однако желтый канал в CMYK,

синий в RGB и В в LAB не так

сильно влияют на детали изобра-

жения, как другие каналы. Поэто-

му некоторый уровень шумов там

вполне допустим, хотя, конечно,

не такой сильный, как на рис.

5.2А. Между тем размытие кана-

лов А и В настолько эффективнее

всех остальных методов устране-

ния шума, что достойно занять

подобающее место в арсенале

серьезного ретушера.

Метод размытия АВ дополняет-

ся столь же эффективным методом

повышения резкости в канале L.

Этот прием занимает довольно

крепкие позиции в кругу профес-

сионалов. Он получил широкое

распространение в первой полови-

не 90-х годов — еще до появления

цифровой фотографии и до того,

как настольные сканеры стали

пригодны для профессионального

применения. В то время казалось,

что новая и доступная по цене тех-

нология Kodak Photo CD открыва-

ет широкие горизонты, обеспечи-

вая прекрасное качество цвета. Но

главный ее недостаток состоял в

том, что изображения получались

не резкими, а плотность в чет-

вертьтонах была недостаточной.

Пространство LAB предлагало

практически идеальное решение
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Рис. 5.2. Синий канал изображения 5.1 полон
цифровых шумов (вверху). Попытки устра-
нить их в RGB или CMYK вызывают потерю
деталей. Внизу: новый синий канал, получен-
ный в результате преобразования файла в
LAB, применения фильтра Dust & Scratches к
каналу В и возврата в RGB.
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этой проблемы. Не надо трогать ка-

налы АВ, все делается только в L:

вы затемняете четвертьтона с помо-

щью кривой, а затем повышаете

резкость — обычно используя для

этого фильтр Unsharp Mask, а ино-

гда и другие, более примитивные

средства.

Если вы не застали те времена,

вам трудно себе представить, в ка-

ких условиях приходилось работать:

применили кривую к большому

файлу — и можете спокойно схо-

дить за сандвичем, пока Photoshop

выполнит эту команду. Добавили к

файлу еще один слой — и двигаете в

ближайший бар пропустить стакан-

чик-другой. А когда, пошатываясь,

вы возвращаетесь на рабочее место,

процесс все еще продолжается.

Думаю, в ту пору популярность

метода повышения резкости в L бы-

ла обусловлена двумя основными

причинами. Во-первых, с техниче-

ской точки зрения результат приме-

нения данной процедуры был луч-

ше, чем при повышении резкости в

RGB, поскольку она не влекла за

собой изменения цвета: бесцветный

канал L на цвет никак не влияет.

И, во-вторых, при черепашьих ско-

ростях работы тогдашних компью-

теров быстрота выполнения задачи

в LAB имела решающее значение.

Системе было проще обработать

один канал, чем три, — особенно ес-

ли учесть, что в стандартной ком-

плектации компьютеры тогда ос-

нащались восьмью мегабайтами

оперативной памяти, а гигабайт

дискового пространства стоил око-

ло тысячи долларов.
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Рис. 5.3. Каналы А (вверху) и В (внизу) переве-
денного в LAB изображения 5.1 обнаружива-
ют присутствие шумов. Чтобы показать
шум нагляднее, к областям в кругах была до-
полнительно применена кривая.
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Шли годы, и оба эти фактора утра-

тили свое значение, или, по крайней

мере, так казалось. 

Во-первых, был найден способ по-

вышения резкости в RGB без изме-

нения цвета — с помощью яркост-

ного наложения, которое можно

проделать двумя путями. Простой,

хотя и менее гибкий путь — обраще-

ние к команде Edit > Fade > Lumino-

sity сразу после повышения резкости

в RGB. Более аккуратный подход

предполагает дублирование слоя, по-

вышение резкости верхнего слоя и

замену режима его наложения с

Normal на Luminosity. Режимы нало-

жения представлены в раскрываю-

щемся списке на палитре Layers.

Во-вторых, мощность компьюте-

ров сегодня неизмеримо возросла, и

повышение резкости выполняется

почти мгновенно, разве что за исклю-

чением случаев обработки очень

больших файлов.

Казалось бы, теперь нет причин

повышать резкость в LAB. Однако,

судя по материалам интернет-фору-

мов, значительное число пользовате-

лей упорно придерживается LAB-ме-

тода, который, по их словам, дает

лучшие результаты. Поначалу я ду-

мал, что это бабушкины сказки.

Но в полиграфии — как в жизни:

бабушки иногда оказываются ум-

нее, чем думают дедушки. Повыше-

ние резкости в L часто действитель-

но дает лучшие результаты, по

крайней мере по сравнению с про-

стым повышением резкости в RGB.

В большинстве случаев LAB-метод

эквивалентен методу RGB/Lumino-

sity, но часто он заметно лучше. Он

также определенно эффективнее,

чем общее повышение резкости в

CMYK, хотя некоторые изображе-

ния выигрывают от повышения рез-

кости в отдельных каналах CMYK.
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О клавиатурных
эквивалентах команд

Photoshop работает почти одинаково на всех
платформах. Клавиша Command на Macintosh
соответствует Ctrl в Windows, а клавиша
Option — клавише Alt. Далее я буду приводить
только клавиатурные эквиваленты Macintosh,
как я поступал более десяти лет.

В начале 2005 года, повинуясь соображе-
ниям политкорректности, я начал использо-
вать в своих журнальных статьях и черновом
варианте этой книги, казалось бы, более
универсальные обороты, типа Command/Ctrl
и Option/Alt. Однако это начинание не увен-
чалось успехом. Пользователи Macintosh ста-
ли писать, что я путаюсь в клавиатуре. На
Macintosh тоже есть клавиша Control, но она
не имеет ничего общего с Ctrl в Windows, а
часть читателей воспринимала Command/Ctrl
как Command плюс Control.

Не зная как быть, я вынес эту проблему на
обсуждение в своей интернет-конференции
Applied Color Theory и попросил посетите-
лей высказать свое мнение. Тема оказалась
весьма актуальной. Я получил примерно 60
откликов, в числе которых немало желчных.
В целом мнения сводились к тому, что чита-
тель, которому трудно переводить в уме кла-
виатурные эквиваленты, очевидно, взялся не
за ту книгу. Согласен.

Пять лет назад большинство моих читате-
лей составляли пользователи Macintosh. По-
дозреваю, что сегодня большинство работает
в Windows. Значит, клавиатурные эквиваленты
Windows давать действительно надо, хотя Ctrl
по-прежнему будет смущать некоторых поль-
зователей Маков. В предыдущих главах я так и
делал. Но, начиная с этой главы, я буду приво-
дить только эквиваленты Macintosh, чтобы
облегчить читабельность текста.

Если вам интересно, можете ознако-
миться со всеми перипетиями той дискус-
сии, включая и мои комментарии. Они на-
ходятся на прилагаемом компакт-диске в
папке этой главы.



Во второй части главы мы рассмот-

рим данный вопрос подробнее, а пока

примем это как данность. Размытие в

LAB с целью устранения шумов дает на-

столько хороший эффект, что с лихвой

оправдывает перевод туда файла из

RGB. Я не уверен, есть ли смысл пере-

ходить в LAB ради одного только повы-

шения резкости, но если вы уже находи-

тесь в этом пространстве и в принципе

планируете поднять общую резкость

изображения, то сделайте это  в LAB.

Выбор канала
В одних случаях повышение резкости

и/или размытие применяются сразу ко

всему файлу, в других, особенно часто

это происходит в CMYK, — к опреде-

ленным каналам. В LAB поканальное

применение данных операций произ-

водится всегда.

Для выбора отдельных каналов удоб-

но использовать клавиатурное сочета-

ние «Command–№ канала». (Прежде

чем двигаться дальше, обязательно про-

чтите врезку на предыдущей странице.)

В LAB комбинация клавиш Command–1

активизирует канал L, Command–2 —

канал А, а Command–3 — канал В. Ком-

бинация Command–~ (тильда) восста-

навливает композитное изображение, а

одиночная клавиша «тильда» показыва-

ет композитное изображение, оставляя

активным только один канал.

Работая с каналами, держите

открытой палитру Channels (ко-

манда Window > Channels). Пик-

тограмма «глаз» в строке канала

означает, что данный канал ви-

ден в данный момент. Если стро-

ка подсвечена, значит, канал

активен и доступен для редакти-

рования. Обычно мы выделяем

или один канал (рис. 5.4 справа),

или все, но иногда нам требуется

выделить два канала одновре-

менно (рис. 5.4 слева). Для этого щелк-

ните на строке второго канала, удержи-

вая нажатой клавишу Shift.

Изображение на рис. 5.5 служит

скорбным напоминанием о той смер-

тельной опасности, которой чревато

освоение космоса. Так выглядел вход в

Космический центр им. Джонсона по-

сле гибели экипажа шаттла «Колум-

бия» из-за разгерметизации кабины.

Здесь видна лишь малая часть трагиче-

ских декораций: линия гирлянд, вен-

ков, флагов тянулась на многие десят-

ки метров.

Эта фотография несет двоякую на-

грузку. Во-первых, она напоминает о

том, что в мире есть вещи поважнее

Photoshop, а во-вторых, демонстрирует

резкие переходы между цветами — в

частности, яркие цвета флагов на фоне

стены. Давайте посмотрим, что проис-

ходит, когда мы размываем каналы АВ,

а затем повышаем резкость в L.

Левая половина рис. 5.4 показывает,

что каналы А и В активны, канал L не-

активен, но все изображение является

видимым. При такой конфигурации

палитры Channels я применяю к изоб-
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Рис. 5.4. Палитра Channels позволяет выбрать один или несколько
каналов для коррекции, блокируя при этом другие каналы. Пикто-
грамма «глаз» показывает, что канал видим, а подсветка означает
доступность канала для редактирования.

Рис. 5.5 (напротив). Каналы А и В выдерживают
сильное размытие без особых негативных последст-
вий. Вверху: оригинал с разрешением 255 пикселов
на дюйм. Посередине: здесь каналы А и В размыты
фильтром Gaussian Blur с радиусом 3.0 пиксела. Ви-
дите ли вы разницу? Нижняя версия показывает, во
что превратится картинка, если с тем же радиу-
сом размыть канал L.
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ражению 5.5А фильтр Gaussian Blur с

радиусом 3.0, размывая только каналы

АВ. Результат на рис. 5.5В выглядит

почти так же, как и оригинал 5.5А.

Вообще говоря, размытие с радиу-

сом 3.0 пиксела никак нельзя назвать

слабым. Чтобы доказать, что это дей-

ствительно так, я изменил конфигура-

цию палитры Channels, сделав актив-

ным только канал L (рис. 5.4 справа),

и задал ему тот же уровень размытия.

В результате версия 5.5С оказалась

загубленной.

Между тем эффект на рис. 5.5В выра-

жен настолько неявно, что лишь трех-

кратное увеличение (рис. 5.6) позволяет

разглядеть изменения. Теперь видно,

что в оригинале красные полосы имели

оранжевые вкрапления. После размы-

тия красный цвет стал более равномер-

ным. Вместе с тем, присмотревшись

внимательнее, можно разглядеть по

краям полос небольшие розовые орео-

лы, растворяющиеся в бе-

лых, вернее, сине-белых об-

ластях.

В нормальном же мас-

штабе на рис. 5.5 не заметно

ни сглаженности красного,

ни розовых ореолов. А раз

так, то и незачем размывать

такие изображения — если

только на то не будет каких-

то особых причин, напри-

мер, если изображение на

печатном оттиске должно

быть больше, чем изначаль-

но планировалось, или если

оригинал настолько не-

контрастный, что требуется

агрессивная коррекция.

Photoshop CS2
выходит в победители

Техника ретуши и коррекции в течение

очень долгого времени почти не меня-

лась. Появившийся в 1994 году Photo-

shop 3 революционизировал этот про-

цесс, предложив концепцию слоев.

Слои являются критичным элементом

многих приемов коррекции, о которых

идет речь в этой книге. 

Насколько я помню (хотя специаль-

но и не проверял), в древней версии

3 можно проделать почти все те трюки,

о которых вы уже прочли или еще про-

чтете, разве что за исключением двух-

трех случаев.

В 2000 году в Photoshop 6 была добав-

лена команда Convert to Profile, кото-

рую я в свое время рекомендовал, но без

которой можно спокойно обходиться.

Значительно более важная команда
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Рис. 5.6. Увеличенные фрагменты
изображений 5.5А (вверху) и 5.5В по-
зволяют рассмотреть эффект раз-
мытия АВ. Обратите внимание на
слегка растушеванные границы ме-
жду цветами.



Shadow/Highlight, появившаяся в Photoshop

CS (2003), представляет особый интерес и бу-

дет подробно рассмотрена в главе 7.

В 2005 году версия Photoshop CS2 пред-

ставила еще одну важную новинку. Скром-

ная с виду команда Filter > Blur > Surface

Blur предлагает наилучший способ решения

многих проблем, с которыми мы сталкива-

лись до сих пор. Для тех, кто работает в CS2,

этот фильтр должен стать первейшим сред-

ством размытия каналов АВ. А поскольку он

нигде как следует не описан, я сейчас рас-

скажу, как он  работает.

Размытие, вне зависимости от того, ка-

кой фильтр вы применяете, обычно исполь-

зуется для устранения шумов в относитель-

Рис. 5.7. Фильтр Surface Blur
(Photoshop CS2) не допуска-
ет размытия четких очер-
таний объектов, как в слу-
чае с оправой очков. Вверху
слева: оригинал. Вверху посе-
редине: результат примене-
ния фильтра Surface Blur с
установками Radius 3, Thres-
hold 10. Вверху справа: по-
вышение величины Radius до
10 усиливает эффект сгла-
живания кожи. Внизу слева:
повысив Threshold до 25, мы
размываем волосы. Внизу
справа: в результате увели-
чения Threshold до 75 стра-
дают серьги и глаза.

A B

D E

C



но однородных цветовых областях, та-

ких как небо или кожа. Но проблема в

том, что шум помогает четче обозна-

чать границы, как например, в случае

с оправой очков на рис. 5.7А. Вообще

говоря, привнесение некоторого шума

составляет принцип действия фильтра

Unsharp Mask, о котором пойдет речь

немного ниже.

Особенность фильтра Surface Blur со-

стоит в том, что он пытается распознать

границы и оставить их нетронутыми.

Если фильтр Gaussian Blur имеет только

параметр Radius, то в Surface Blur есть

еще и параметр Threshold, который по-

зволяет задавать пороговое значение.

Программа сравнивает каждый пиксел

размытой и неразмытой версий и, если

разница превышает указанное порого-

вое значение Threshold, эти пикселы не

размываются. Соответственно, чем вы-

ше величина Threshold, тем ярче выра-

жен эффект  размытия, что способно

сбить с толку пользователей-ветеранов,

привыкших к тому, что тот же параметр

Threshold в фильтре Unsharp Mask дает

противоположный эффект.

Сглаживание кожи на фотографиях

стареющих женщин — обычное требо-

вание заказчика. Это довольно кропот-

ливая работа, включающая изрядную

долю ручного труда. Поскольку гораздо

удобнее отслеживать изменения, когда

у вас перед глазами цветное изображе-
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Как и когда использовать размытие.
Полезные советы

Прежде чем обращаться к какому-либо из многочисленных инструментов размытия
в Photoshop, необходимо удостовериться в том, что оно действительно необходимо.
Для начала следует проверить каналы, пока файл еще пребывает в RGB. Шум в синем
канале (соответственно, желтом канале в CMYK и канале В в LAB) должен быть до-
вольно значительным, иначе нет смысла его размывать, поскольку он и так не будет
особенно заметен на печати. А вот если есть шум в других каналах, действовать следу-
ет более решительно.

Если изображение имеет очень слабый контраст и нуждается в интенсивной кор-
рекции, размытие каналов АВ представляется особенно желательным, так как с уси-
лением цвета шум тоже усилится. Размытие АВ может понадобиться и в том случае,
если печатное изображение должно быть большего размера, нежели это допускает
его разрешение — сравните версии 5.5В и 5.6В.

Пользователям Photoshop CS2 и более поздних версий для размытия следует в пер-
вую очередь обращаться к фильтру Surface Blur. Что касается предыдущих версий, там
хорошие результаты дает фильтр Gaussian Blur с радиусом не более 3 пикселов, хотя
для полного устранения шумов этого может быть недостаточно. В таком случае можно
воспользоваться фильтром Dust & Scratches. Он не образует заметной каймы, как
Gaussian Blur, но может переусердствовать по части нивелирования цветовых вариаций.

Другие фильтры размытия, возможно, тоже имеют свои достоинства, но я недоста-
точно много экспериментировал с ними, чтобы рекомендовать какой-либо из них в
качестве альтернативы. Замечу лишь, что нет смысла применять фильтр Despeckle. Уж
лучше Median или Motion Blur.

В большинстве случаев каналы АВ следует размывать по отдельности. Причем ка-
нал В требует более интенсивного размытия, поскольку больше подвержен шумам.
Хотя, конечно, бывают и исключения.



ние, а не серые каналы АВ, давайте на

время перейдем в RGB.

Чем больше объект, тем больший ра-

диус нужен для его размытия. Не обрежь

я столь бесцеремонно эту фотографию,

она заняла бы всю страницу. Даже ради-

ус 3 (к сожалению, Surface Blur пока не

работает с десятыми долями пиксела)

кажется здесь довольно скромным. На

рис. 5.7В он дополнен столь же скром-

ной величиной Threshold 10. Это дает

умеренное сглаживание кожи и не-

сколько меньшее сглаживание волос.

С повышением величины Radius до

10, когда размытие сглаживает крупные

дефекты кожи, эффект становится за-

метнее (рис. 5.7С).

Повышение величины Threshold до

25 в версии 5.7D стирает большую часть

деталей в волосах и сглаживает кожу,

хотя и не столь сильно. Но смотрите:

брови, оправа очков и серьги почти не

пострадали. Чтобы размыть их, понадо-

бится увеличить величину Threshold аж

до 75 — как в версии 5.7Е. Если бы вме-

сто Surface Blur мы использовали

фильтр Gaussian Blur, все эти объекты

давно превратились бы в кашу.

Surface Blur действительно очень

гибкий инструмент, но здесь следует от-

метить пару моментов. Во-первых,

фильтр требует интенсивных вычисле-

ний и процесс обработки может про-

должаться достаточно долго, особенно,

когда файл большой. Во-вторых, при-

менять его лучше к дубликату слоя с не-

прозрачностью менее 100%. Взгляните

на неестественную однородность кожи

в последних трех версиях на рис. 5.7.

Этот фильтр скорее стирает все разли-

чия, чем смягчает их. Поэтому прихо-

дится частично восстанавливать исход-

ную текстуру.

Итак, уяснив, как защитить резкие

границы между цветовыми областями,

обратимся к фильтру, который поможет

сделать их еще четче.

Маленький шаг для человека
Повышение резкости, или говоря тех-

ническим языком, нерезкое маскиро-

вание — это искусственный способ

придания изображению кажущейся

сфокусированности. Он не помешает

практически любому изображению, но

не потому, что фотографы органически

неспособны сделать хорошо сфокуси-

рованный снимок, а потому, что печат-

ный процесс размывает картинку.

В идеальном мире стыки белых и

красных полос должны быть исключи-

тельно четкими. Если бы это была век-

торная картинка, созданная в Adobe

Illustrator, с абсолютно горизонталь-

ными и вертикальными полосами, так

бы оно и было. Здесь же полосы на-

клонные, и их очень неудобно воспро-

изводить с помощью квадратных пик-

селов. Чтобы сделать диагональную

линию, мы должны расположить пик-

селы ступеньками. Если увеличить

картинку посильнее, эти ступеньки

становятся отчетливо заметными.

А если они вдобавок чисто-красные и

чисто-белые, то будут заметны даже в

нормальном масштабе. Поэтому на

стыках красной и белой областей про-

грамма автоматически делает пикселы

розовыми — и этот компромисс назы-

вается сглаживанием.

На рис. 5.8 показана версия изобра-

жения 5.5А с повышенной резкостью.

Здесь же приводится увеличенный

фрагмент изображения с чрезмерной

резкостью, чтобы стало понятно, как

достигается нужный эффект. В нор-

мальном масштабе такая картинка вы-

глядит просто более четкой — а это как

раз то, для чего и существует нерезкое

маскирование.

Увеличенный фрагмент раскрывает

секрет. Ступеньки никуда не делись:

они стали незаметными благодаря про-

стому трюку. Края красных полос сде-

лались темнее, а белых — светлее. Пере-
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ход между цветами стал выглядеть кон-

трастнее, четче и убедительнее.

Про фильтр Unsharp Mask (USM),

основной инструмент фокусировки,

можно написать целую книгу. В моих

книгах серии «Photoshop для профес-

сионалов» работа этого фильтра рас-

сматривается более подробно, чем

здесь. Существует множество способов

применения Unsharp Mask: раздельное

осветление и затемнение на разных

слоях, повышение резкости через мас-

ку, а новая разновидность этого фильт-

ра, Smart Sharpen, появившаяся в

Photoshop CS2, позволяет проделывать

то и другое. Все эти методы работают в

LAB, и часто успешнее, чем в других

цветовых пространствах.

В LAB вся фокусировка должна вы-

полняться только в канале L. Попро-

буйте поднять резкость в А и/или В —

результат будет, мягко говоря, интерес-

ный. Цель нерезкого маскирования со-

стоит в том, чтобы акцентировать дета-

ли, а не создавать психоделические цве-

та. Между тем манипуляции в L никак

не влияют на цвет.

Вспомним изображение на рис. 1.7.

Там я применял фильтр Unsharp Mask с

установками по умолчанию: Amount

200%, Radius 1.0, Threshold 10. Установ-

ки по умолчанию всегда слишком кон-

сервативны. Слишком хорошо сфоку-

сированных изображений не бывает, но

бывают изображения с искусственно

завышенной резкостью. Вся сложность

в том, чтобы, подбирая числа, добиться

первого и не допустить второго.

Параметры в диалоговом окне филь-

тра Unsharp Mask позволяют контроли-

ровать характеристики темных и свет-

лых ореолов вдоль цветовых границ,

которые были наглядно продемонстри-

рованы во врезке на рис. 5.8. Чем выше

значение Amount, тем темнее и светлее

соответствующие ореолы. Для фраг-
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Рис. 5.8. После применения фильтра
Unsharp Mask изображение выглядит более
сфокусированным. Увеличенный фрагмент
слева раскрывает секрет этого чуда: на
стыках двух цветов края темных облас-
тей (красные полосы) становятся еще
темнее, а края светлых — еще светлее.



мента во врезке и для основного

изображения были заданы раз-

ные установки. Чтобы лучше

подчернуть ореолы во врезке, я

довел величину Amount до 500%.

Применительно к основному

изображению я задал всего

300%, иначе оно стало бы слиш-

ком грубым.

Настроить параметр Amount

довольно просто. Обратите вни-

мание, что нельзя правильно

оценить эффект, если картинка

на экране отображается в невер-

ном масштабе — это типичная

ошибка. Чтобы правильно оце-

нить результат изменения Amo-

unt, установите масштаб про-

смотра 100% или воспользуйтесь

командой View > Actual Pixels.

Величина Radius определяет

ширину ореолов, а не степень

их осветления или затемнения.

В изображении на рис. 5.8 ис-

пользован радиус 1.0, тогда как

во врезке я для большей нагляд-

ности поднял его до 5.0. Более

высокое значение Radius губит

детали. Взгляните, насколько

равномерна текстура внутри

ореолов в отличие от областей,

не подвергшихся изменениям. 

Главное при выборе радиуса

решить, готовы ли вы смирить-

ся с подобной потерей деталей.

Если бы флаг был единствен-

ным объектом в изображении,

можно было бы задать больший

радиус, поскольку во флаге

очень мало деталей. Но боль-

шие бесформенные ореолы,

особенно белые, вокруг букв на

стене с ярко выраженной текс-

турой будут смотреться весьма

неприглядно.

Параметр Threshold контро-

лирует уровень шумов. Чем
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Большое значение Radius,
малое значение Amount

Во многих случаях канал L допускает применение
альтернативного метода повышения резкости:
фильтра Unsharp Mask с очень большим значени-
ем Radius и малым значением Amount. Если нор-
мальная величина Radius составляет 1.0, то здесь
она может варьироваться от 7 до 20 пикселов.
А величина Amount не должна превышать 100%,
тогда как обычно она бывает гораздо больше.

Два метода повышения резкости преследуют
разные цели. Если обычный метод подчеркивает
границы цветовых областей, то альтернативный
(назовем его hiraloam — high Radius, low Amount) —
придает объектам форму. Встречаются изображе-
ния с большим количеством шумов, которым не
удается придать хорошую резкость обычным мето-
дом, а альтернативный метод здесь дает лучшие ре-
зультаты. 

Некоторые пользователи, пытаясь получить аль-
тернативный эффект, дублируют слой, задают ре-
жим наложения Overlay и применяют фильтр High
Pass из меню Filter > Other. Этот способ не только
более громоздкий, но и менее гибкий, поскольку в
нем отсутствует параметр Threshold, что затрудня-
ет подбор оптимального значения Radius.

Детальное рассмотрение альтернативного ме-
тода выходит за рамки этой книги, отмечу лишь,
что в LAB он дает лучшие результаты, чем в RGB.
Если вы хотите поэкспериментировать, советую
начать с какого-нибудь портрета. Переведите
файл в LAB и примените к каналу L фильтр Unsharp
Mask со следующими параметрами: Amount
500%, Radius 15.0, Threshold 0. Картинка будет вы-
глядеть ужасно, зато покажет, правильно ли уста-
новлено значение Radius. Ищите такое значение,
которое поможет подчеркнуть форму глаз и скул.
Если это значение слишком велико, все лицо ока-
жется осветленным. Если слишком мало — изо-
бражение будет выглядеть абсурдно. Найдя под-
ходящий радиус, уменьшите значение Amount до
50%. В отличие от обычного метода повышения
резкости, альтернативный оставляет гораздо мень-
ше заметных артефактов и может применяться на
любой стадии коррекции изображения.



меньше его значение, тем резче будут

выглядеть границы между областями

разных цветов, например, между белы-

ми и красными полосами на флаге.

Для врезки на рис. 5.8 использовано

нулевое значение Threshold, и в увели-

ченном виде внутри красных полос

видны дополнительные цветовые ва-

риации, хотя оригинал не особенно

шумный. Для основного изображения

с меньшей величиной Amount я тоже

задал Threshold 0. Оригиналы погрубее

требуют более высокого значения

Threshold, которое снижает интенсив-

ность даже резко обозначенных цвето-

вых границ. Поэтому повышенная ве-

личина Threshold во многих случаях

должна сопровождаться повышенным

значением Amount.

Взлет состоялся
Подбор верных установок резкости —

один из показателей профессионализма

ретушера. Если изображение предназна-

чено для печати, повышение резкости

стоит отложить до тех пор, пока файл не

будет преобразован в CMYK. Это в осо-

бенности касается изображений, в кото-

рых превалирует какой-либо один цвет.
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Вопросы и упражнения
√ Представьте, что вы собираетесь открыть новое RGB-изображение, ни-

чего не зная о нем. В каком канале будет больше всего шумов? Куда они
перекочуют, если вы переведете файл в LAB?

√ Каких серьезных негативных последствий применения фильтра Gaussian
Blur к каналам АВ позволяет избежать фильтр Surface Blur, который поя-
вился в Photoshop CS2?

√ Чем отличаются параметры Amount и Radius, представленные в диалого-
вом окне фильтра Unsharp Mask?

√ Какого дефекта, связанного с повышением резкости в RGB, помогает из-
бежать повышение резкости в канале L?

√ Как не допустить изменения цветов при повышении резкости в RGB?

√ Возьмите прилагаемый к этой книге компакт-диск и откройте файл с фо-
тографией Йеллоустонского озера. Повысьте резкость в канале L, задав
большое значение Radius (>10 пикселов) и малое значение Amount
(<100%). Сравните это с результатом, который дает обычный метод с
Amount >300% и Radius 1.0.

√ Откройте три ваших собственных файла с разными по характеру изо-
бражениями. Преобразуйте их в LAB и примените к каналам АВ фильтр
Gaussian Blur с радиусом 4.0 пиксела. Во всех ли изображениях отчетли-
во различим эффект размытия? Если нет, отрегулируйте параметры, что-
бы эффект стал заметен. Теперь объясните, почему в некоторых изобра-
жениях размытия долго не было видно?



Тогда повышение резкости в двух слабых

каналах CMYK дает лучший результат,

чем в канале L или в каналах RGB. На-

пример, резкость лесной растительности

лучше поднимать в черном и пурпурном

каналах CMYK — если, конечно, ваш

рабочий процесс допускает это. Изобра-

жения со множеством разных цветов,

как на снимке Космического центра им.

Джонсона, с которым мы только что ра-

ботали, выигрывают от повышения рез-

кости во всех каналах или в канале L. Ес-

ли в конечном итоге вы планируете

перевести файл в CMYK и там серьезно

поработать над ним, повышение резкос-

ти следует отложить до завершения

коррекции.

Итак, суммируем то, о чем мы узнали

в этой главе. Если изображение содер-

жит слишком много цветовых шумов,

его определенно стоит перевести в LAB

и размыть каналы А и В. Что касается

повышения резкости, здесь рекоменда-

ции будут не столь однозначными. Не-

которые ретушеры специально перехо-

дят в LAB для повышения резкости в

канале L. Если это и оправданно, то

лишь в немногих случаях, потому что

общее повышение резкости в RGB час-

то работает не хуже. Хотя если вы все

равно собираетесь корректировать изо-

бражение в LAB, то там же можно по-

высить и резкость.

Один из читателей предварительной

версии этой книги, Андре Дюма, выра-

зился по этому поводу так: «Не согла-

сен. Как фотограф я нахожу, что повы-

шение резкости в канале L почти всегда

лучше. Если же фотография готовится

для печати, то я могу дополнительно

поднять резкость еще и в некоторых ка-

налах CMYK. Почему бы не предло-

жить и такую альтернативу?».

Вполне справедливое замечание. Но

я пойду еще дальше. Если вы готовите

файл для печати и хотите, чтобы кар-

тинка получилась по-настоящему рез-

кой, могу предложить вам такой ма-

невр: создайте две копии LAB-файла и

поднимите резкость в одной из них, за-

тем переведите обе копии в CMYK и за-

мените черный канал резкой копии

черным каналом нерезкой. Вы можете

атаковать этот новый черный канал, не

опасаясь ненароком усилить артефак-

ты, которые могли быть туда привнесе-

ны в LAB.

А теперь, если вы не склонны дока-

пываться до сути вещей и вас не осо-

бенно волнует, почему что-то происхо-

дит именно так, а не иначе, можете

сразу перейти к следующей главе. Если

же вам интересно сравнить разные ме-

тоды коррекции и узнать подробнее о

некоторых преимуществах LAB перед

RGB, дочитайте эту главу до конца.

Повышаем резкость в L, размываем АВ 151



Изображение на рис. 5.9 я опублико-
вал еще в 1996 году, агитируя за повы-
шение резкости в канале L. Здесь такие
же яркие и контрастные цвета, как на
фотографии Космического центра им.
Джонсона. Границы между красной
майкой и зеленым фоном столь же чет-

кие, как между красными и белыми по-
лосами флага. То же касается контрас-
та между телесными тонами и фоном,
телесными тонами и майкой.

На рис. 5.10А показан результат по-
вышения резкости в канале L с такими
же чрезмерными установками (Amount
500%, Radius 5.0, Threshold 0), что и во
врезке на рис. 5.8. Они же использова-
ны и в версии 5.10В, но здесь нерезкое
маскирование применялось сразу ко
всему RGB-файлу.

Повышая резкость во всем файле,
мы фактически повышаем ее в каждом
канале, что приводит к появлению мас-
сы хорошо заметных дефектов (рис.
5.10В). В зеленом канале RGB майка
темная, а фон светлый, поэтому на вну-
тренней границе майки появился тем-
ный ореол, а на внешней — светлый.
В красном канале, наоборот, майка
светлая, а фон темный. Соответственно
граница майки становится светлой, а
граница фона — темной. 

Такая комбинация затемнения и
осветления образует вокруг майки яр-
кий сине-зеленый ореол. Тот же самый
дефект наблюдается на границе между
шеей и воротником майки. Вот из-за
таких ореолов нерезкое маскирование
и пользуется дурной славой. Возмож-
но, на фотографиях марсиан, которые
когда-нибудь продемонстрирует нам
NASA, зеленая кожа и будет выглядеть
естественно, но в данном случае она
по меньшей мере неуместна. Поэтому
если фотограф чувствует, что его мо-
дель недостаточно накрашена, ему все
же следует пригласить гримера, а не
пытаться наводить марафет с помо-
щью нерезкого маскирования. Здесь
же с повышением резкости глаза ока-
зались подведенными, а на губах по-
явилась помада.

Версия 5.10А лишена этих дефек-
тов, так как манипуляции с каналом L
никак не влияют на цвет. Однако ее
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Пристальный
взгляд

Рис. 5.9. Это изображение с четкими границами между
цветовыми областями было использовано в одной из ста-
тей 1996 года для демонстрации результатов повышения
резкости.



следует сравнить с третьей, более
элегантной альтернативой.

Когда RGB ведет себя
почти как LAB 

Как отмечалось в первой части этой
главы, Photoshop предлагает два спо-
соба повышения резкости вне LAB,
которые позволяют ограничивать из-
менение цветов. Первый и наиболее
гибкий предполагает дублирование
RGB-слоя и повышения резкости на
нем. Затем следует задать режим на-
ложения Luminosity, при котором те-
оретически используется цвет с ниж-
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Рис. 5.10. Увеличенные фрагменты помогают обна-
ружить некоторые дефекты. Вверху слева: резуль-
тат повышения резкости в канале L пространства
LAB. Внизу слева: результат применения Unsharp
Mask к RGB-файлу с теми же установками. Внизу
справа: резкость, повышенная в каналах RGB, была
сразу ослаблена с использованием режима наложения
Luminosity.



него слоя, а детали с верхнего,
создавая таким образом, опять
же теоретически, тот же эффект,
что и повышение резкости в ка-
нале L. Второй, более простой
способ — поднять резкость в RGB
и сразу же ослабить эффект ко-
мандой Edit > Fade > Luminosity. 

И тот и другой методы дадут
версию 5.10С. Она явно лучше,
чем 5.10В. Но так ли хороша, как
5.10А? В нормальном масштабе,
возможно, и хороша. Но если
изображение увеличить, обна-
руживаются проблемы. 

В LAB-версии лучше детали-
зация волос и глаз. Лицо кажет-
ся чуть более светлым, что то-
же хорошо. Тени на воротнике
здесь выглядят естественными,
тогда как в версии RGB/Lumi-
nosity красный цвет слишком
яркий.

Наибольшее различие наблю-
дается в самых светлых областях
лица. На рис. 5.10С некоторые
части ушей получились белыми —
здесь совершенно исчезли рас-
тровые точки. В версии 5.10А, где
телесные тона в целом светлее,
уши имеют очень естественный
розоватый оттенок. Возможно,
белые уши и не такой серьезный
дефект, как зеленая шея на рис.
5.10В, но все равно они не дают
нам повода для радости. 

Как такое могло произойти?
Почему побелели уши и изме-
нился цвет воротника? Ведь этот
метод предназначен специально
для сохранения цвета.
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Рис. 5.11. Надпись на щите (вверху) вызы-
вает проблемы при повышении резкости.
В средней версии резкость повышена в ка-
нале L, а в нижней — методом RGB/Lumi-
nosity. В обоих случаях использовались оди-
наковые установки.
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При подготовке этой главы я ото-
брал около 30 разных по характеру изо-
бражений, где могли проявиться дефек-
ты при повышении резкости, и создал
по две копии каждого из них. В одной
копии я поднял резкость в L, в другой
использовал метод RGB/Luminosity с те-
ми же установками.

Примерно половина из этих пар ока-
зались настолько близкими, что разли-
чить их было практически невозможно.
Чтобы заметить отличия, приходилось
помещать две копии на разные слои и
сравнивать их в масштабе 200%, пере-
ключаясь с одной на другую. 

В то же время примерно у четверти
всех изображений LAB-версии выгля-
дели немного лучше (далее показано
одно из них) и еще у одной четверти —
они выглядели гораздо лучше. В одном
случае лучшей оказалась RGB-версия,
но этот факт настолько необычен, что
его можно проигнорировать.

Существуют два фактора, которые
позволяют LAB-методу давать лучшие
результаты. Если вы заметите, что они
присутствуют в изображении — не за-
думываясь повышайте его резкость в
LAB. В остальных случаях метод
RGB/Luminosity срабатывает не хуже.
Рассмотрим по одному примеру для
каждого из этих факторов.

Хьюстон, у нас проблемы
Сравним результаты, которые дает по-
вышение резкости в канале L и метод
RGB/Luminosity с теми же установками.
Как мы уже видели на примере 5.10А,
поднимать резкость в RGB без обраще-
ния к режиму наложения Luminosity не
имеет смысла.

Сначала возьмем картинку попро-
ще. Для каждой из версий на рис. 5.11
использованы следующие установки:
Amount 500%, Radius 1.5, Threshold 0.
LAB-версия на рис. 5.11В выглядит
лучше всех, и фрагмент на рис. 5.12В
помогает понять, почему это происхо-
дит. При большом увеличении в
RGB/Luminosity-версии становятся
видны белые ореолы вокруг красных
букв. Впрочем, на желтом фоне они
почти незаметны.

Эти области, равно как и уши девуш-
ки на рис. 5.10С, побелели по одной и
той же причине — по той же, по кото-
рой столь эффективными оказались
кривые LAB на рис. 2.8 с изображением
заката. Законы цветового охвата про-
странств RGB и CMYK требуют, чтобы
самые светлые пикселы в изображении
были белыми. Образовавшиеся после
повышения резкости ореолы стали мак-
симально светлыми и поэтому обесцве-
тились. Режим наложения Luminosity
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Рис. 5.12. В увеличенных фрагментах версий 5.11В (LAB-метод, слева) и 5.11С (метод RGB/Luminosity, справа) видна
разница в качестве. Справа на желтом фоне вокруг букв появились белые ореолы: Photoshop не в силах изменить свет-
лоту ореолов, поэтому не может сделать их желтыми. В LAB-версии желтый цвет фона остался без изменений.
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требует от Photoshop восстановить ис-
ходный желтый цвет, но это уже невоз-
можно: программа попросту не может
создать в RGB цвет, которого в этом
пространстве не существует.

С каналом L дело обстоит иначе.
Желтый фон в среднем показывает 96L

(6)A 40B. После повышения резкости в L
образуются светлые и темные орео-
лы — также как в RGB. В данном случае
не требуется особо сильного осветле-
ния, чтобы достичь максимального зна-
чения 100L.

Здесь мы вступаем в мир вообража-
емых цветов. Файл выдает запрос на
цвет 100L (6)A 40B, которого не сущест-
вует ни в RGB, ни в CMYK. Этот цвет
должен быть предельно светлым, как

чисто-белый, и в то же время содер-
жать изрядное количество желтого.

Сталкиваясь с воображаемыми цве-
тами, Photoshop пытается найти ком-
промиссное решение. В результате мы
получаем желтый, хотя и не такой, как
остальной фон. Еще мы получаем свет-
лые ореолы, но опять же не настолько
светлые, как в версии 5.12В.

Выброс гамма-радиации
Есть и еще одна категория изображе-
ний, где LAB демонстрирует преимуще-
ство при повышении резкости. Здесь
разобраться будет несколько сложнее.

Прежде всего удостоверимся, что
такое преимущество действительно
есть. На рис. 5.13 показан оригинал, а
на рис. 5.14 — две соперничающие вер-
сии, резкость в которых была по-
вышена с одинаковыми установками:
Amount 500%, Radius 1.5, Threshold 0.
В LAB-версии 5.14А листья выглядят
более привлекательно, что особенно
заметно при большом увеличении. 

Версия 5.14А выглядит светлее, чем
5.14В, но не потому, что LAB-метод ка-
ким-то чудесным образом осветляет кар-
тинки. Вспомните: изображение на рис.
3.10В после повышения в нем резкости в
LAB стало темнее RGB-версии. Как мы
узнаем из следующей главы, изображе-
ние можно сотни раз перегонять из RGB
в LAB и обратно и если при этом с ним
больше ничего  не делать, его совершен-
но невозможно будет отличить на оттис-
ке от нетронутой версии. Значит, в изоб-
ражении 5.13 есть какая-то особенность,
из-за которой после повышения резко-
сти в канале L картинка посветлела.

Хотя версия 5.14А немного лучше,
нельзя сказать, что разница настолько
заметна, чтобы из-за нее пускаться в
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Рис. 5.13. Узкие листья пальм вызывают проблемы
при повышении резкости в изображении.



пространные технические пояснения.
К сожалению, понимание незначитель-
ного преимущества LAB в повышении
резкости необходимо для понимания
значительного преимущества LAB в
размытии — а это уже помогает понять,
почему, собственно, LAB является наи-
лучшим пространством для ретуши. Так
что начнем.

Прежде всего отметим, что сущест-
вует несколько разновидностей RGB.
Эта книга опирается на пространство
sRGB, которое на сегодняшний день
является наиболее распространенным.
Предположим, мы хотим рассказать об
sRGB человеку, который понятия не
имеет, что это такое. Итак, что мы
должны ему поведать?
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Рис. 5.14. Два варианта повышения резкости с одинаковыми установками. LAB-версия (слева) выглядит светлее
RGB-версии (справа), в которой для ослаблении эффекта был использован режим наложения Luminosity. Увеличенные
фрагменты внизу позволяют заметить, что в LAB-версии блеск листьев более привлекателен.
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Это как минимум пять вещей. Пер-
вые три вполне очевидны: мы долж-
ны объяснить, что мы подразумеваем
под красным, зеленым и синим цвета-
ми, потому что разные люди понима-
ют их по-разному. По ходу объясне-
ния мы воспользуемся числами LAB.
Если понятие красный довольно рас-
тяжимое, то числа 54L 81A 70B очень
конкретны. Они определяют красный
цвет в пространстве sRGB, который
там передается значениями 255R 0G

0B. Красному в других разновиднос-
тях RGB соответствуют другие значе-
ния LAB. Например, в относительно
ярком пространстве Adobe RGB тот
же красный 255R 0G 0B определяется
как 63L 90A 78B.

Четвертый момент — это белая
точка, которая говорит, что подразу-
мевается под величиной 255R 255G

255B: чистый белый, не очень чистый
белый. Этот параметр никак не влия-
ет на то, о чем идет речь в нашей кни-
ге, поэтому я не буду на нем останав-
ливаться.

Пятый момент является ключевым
для изображения на рис. 5.14. Почти
во всех разновидностях RGB одинако-
вые величины красного, зеленого и си-
него образуют нейтральный цвет. То
есть 128R 128G 128B означает серый.
Вопрос: насколько темным должен
быть этот серый? Значения каждого
канала указывают на середину между
максимумом 255 и минимумом 0. А се-
рый тоже должен находиться  на пол-
пути к чисто-черному? И если да, то
на чей взгляд? Прибора или человека?

Ответ на эти насущные вопросы
дает значение гаммы. Гамма 1.0 озна-
чает, что с точки зрения прибора
средняя точка находится точно на
полпути между двумя крайними ве-
личинами. Большинство теоретиков
цвета возражают против такой чисто
формальной структуры, совершенно
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256 уровней на канал
Разные числовые системы, когда в одной
256 градаций, в другой 100, способны вве-
сти пользователя в заблуждение. Некото-
рые уверены, что каналы разных цветовых
пространств не совместимы между собой.
Это не так. Вы запросто можете вставить го-
лубой канал CMYK-файла в канал А — если,
конечно, у вас хватит смелости.

В цифровом информационном про-
странстве каждый пиксел канала определя-
ется восемью битами — восемью разряда-
ми, каждый из которых может иметь одно
из двух значений: ноль или единицу. Соот-
ветственно два разряда будут иметь четыре
возможных значения, три разряда — во-
семь и т. д. Восемь бит определяют 256
возможных значений, или 256 тоновых
уровней.

Но тогда почему в RGB максимальное
значение составляет лишь 255? Дело в том,
что ноль — такая же равноправная величи-
на, как и остальные. Это объясняет и асим-
метрию в каналах АВ, где холодные цвета
могут иметь значения до –128, а теплые
только до +127.

Наверное, печатникам неудобно считать
до 256, или же они настолько привыкли к
процентам, что не желают переучиваться,
поэтому информацию о CMYK- и о
grayscale-файлах, а также о канале L Photo-
shop выдает в величинах от 0 до 100. Но в
действительности там используются все те
же 256 возможных значений.

Кроме того, с помощью команды Image >
Mode > 16-bits/channel можно удвоить раз-
рядность файла, что теоретически дает
65 536 возможных уровней серого, хотя нам
по-прежнему выдается информация по шка-
ле от 0 до 255. Я не рекомендую использо-
вать эту команду: многократные тесты показа-
ли, что повышенная разрядность практиче-
ски не влияет на качество изображения. Хотя
вреда от нее тоже не будет — разве что не-
удобство от разбухшего файла.



обоснованно отмечая, что в темных об-
ластях изображения человек различает
контраст лучше, нежели в светлых. Сле-
довательно, при гамме 1.0 разница
между 200R 200G 200B (это очень свет-
лый серый) и 195R 195G 195B будет за-
метна меньше, чем, скажем, между
100R 100G 100B и 95R 95G 95B. Такая не-
равномерность восприятия предпола-
гает использование поправочного ко-
эффициента. По мнению теоретиков
цвета, в качестве средней точки следу-
ет устанавливать более темный оттенок
серого, нежели тот, который опреде-
лен прибором. Тогда тона темнее от-
метки 128R 128G 128B будут распола-
гаться плотнее, а более светлые тона —
дальше друг от друга. 

В главе 13 эта тема будет рассмот-
рена более подробно, а сейчас нам до-
статочно запомнить, что чем выше зна-
чение гаммы, тем темнее средняя
точка. Следует также отметить, что ос-
новная масса пользователей работает с
одной из двух величин: 1.8, которая
является традиционной установкой
гаммы на Macintosh, или 2.2 — тради-
ционная установка на РС. В простран-
ствах sRGB и Adobe RGB используется
гамма 2.2.

Еще одна разновидность RGB, про-
странство Apple RGB, имеет гамму 1.8.
Там величина 128R 128G 128B эквива-
лентна 61L 0A 0B. В sRGB, где поправоч-
ный коэффициент еще выше, этот экви-
валент составляет 54L 0A 0B. Посмотрите
на эти цифры, и вам все станет ясно.

Ни в одном из этих двух искусст-
венно затемненных RGB-пространств
средняя точка не является столь же
темной, как 50L.

Почему повышение резкости в L
дает лучшие результаты

Канал L выглядит не совсем так, как
Grayscale-версия RGB-файла, какая бы

гамма при этом ни использовалась. Тем
не менее в грубом приближении он по-
хож на RGB-файл с гаммой 2.6 или 2.7.

Поскольку интерпретация L столь
темна, его содержание должно быть
светлее, чем можно ожидать. Как явст-
вует из примера на рис. 5.15, канал L не
только светлее, чем результат преобра-
зования в градации серого, но и свет-
лее любого из каналов RGB.

Процесс повышения резкости до-
вольно сложен. В RGB резкость повы-
шается в каждом из трех каналов,
затем происходит усреднение их значе-
ний. В LAB сначала производится ус-
реднение, а потом повышается рез-
кость. Неудивительно, что результаты
немного различаются.

Метод «первоначального усредне-
ния» дает благотворный эффект почти
для всех изображений, включая и то,
что мы рассматриваем. Здесь красный
канал слишком темен, а синий вообще
ужасен, и повышать там резкость беспо-
лезно. А при переводе файла в LAB про-
исходит усреднение этих каналов в со-
вокупности с зеленым, и образованный
в результате канал L имеет более широ-
кий диапазон тонов в области деревьев,
нежели любой из каналов RGB — осо-
бенно если мы вспомним, что L должен
стать светлее в любом случае, чтобы
компенсировать более высокое значе-
ние своей «гаммы».

Впервые за время своей писатель-
ской карьеры я чуть было не поддался
соблазну включить сюда гистограмму.
Я никогда не делаю этого, чтобы у чи-
тателя не сложилось впечатления, буд-
то гистограммы имеют какое бы то ни
было значение для цветокоррекции.
Гистограмма этого изображения пока-
зала бы, что в канале L деревья зани-
мают значительно более широкий диа-
пазон тонов, нежели в зеленом канале,
не говоря уже о красном и синем.
А чем шире диапазон тонов, тем при-
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влекательнее будет выглядеть резуль-
тат повышения резкости.

Можете считать этот тип контраста
в средних тонах и тенях хорошим пово-
дом для путешествия в LAB. Пред-
ставьте себе фотографию женщины с
длинными волосами. Повышая рез-
кость, следует соблюдать осторож-
ность, чтобы не усилить нежелатель-
ных деталей в лице. А вот волосы
должны быть резкими всегда. 

Главное в таком изображении — за-
дать верное значение Threshold в окне
фильтра Unsharp Mask. Но при этом не-
обязательно обра-
щаться к LAB. Как
это ни странно,
здесь все зависит
от цвета волос.

Если на фото-
графии изобра-
жена блондинка,

то метод RGB/Luminosity может лишить
волосы желтизны, как это было на рис.
5.11С. А может, этого и не произойдет.

Если волосы русые, то мы, пожалуй,
не увидим никакой разницы между по-
вышением резкости в канале L и мето-
дом RGB/Luminosity.

Иное дело, когда женщина шатенка
или брюнетка. Целевой объект будет
довольно темным, и LAB проявит свои
преимущества во всем блеске. Повы-
шение резкости в канале L придаст во-
лосам изящность и мягкость, недости-
жимые в RGB.
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Green Blue

L Grayscale

Рис. 5.15. Канал L имеет свои
странности. Средняя точка
его тонового диапазона ин-
терпретируется как довольно
темная, поэтому сам канал
должен быть светлее. Вверху:
канал L (слева) светлее, чем
Grayscale-версия изображения
5.13 (справа). Внизу: ориги-
нальные красный, зеленый и си-
ний каналы, и каждый из них
темнее, чем канал L.

Red



Те, кто предпочитают пользоваться
командой Image > Adjustments > Sha-
dow/Highlight, появившейся в Photo-
shop CS, найдут, что в LAB манипуля-
ции с тенями дают лучший результат,
чем в RGB. Причина та же самая. В гла-
ве 7 нам встретится пример, поясняю-
щий, как и почему это происходит.

Размытие —
это не просто усреднение

Преимущество повышения резкости в
LAB (если оно вообще есть) весьма не-
значительно, тогда как преимущество
размытия поистине огромно. А в про-
цессе коррекции это преимущество
возрастает, поскольку, как отмечалось
во врезке на этой странице, размытие
следует выполнять на ранней стадии
редактирования. 

Предположим, вам нужен цвет, на-
ходящийся между ярко-зеленым и яр-
ко-красным. Речь в данном случае идет
не о наложении зеленой краски поверх
красной, что даст сплошную грязь, а
именно о промежуточном цвете.

Очевидно, это должен быть какой-
то оттенок желтого. Красный и зеленый
не являются противоположными цвета-
ми, тогда как пурпурный и «зеленый»
LAB (который выглядит скорее бирюзо-
вым) являются. У красного и настояще-
го зеленого есть общий компонент —
желтый, следовательно, средним меж-
ду ними будет некий приглушенный
желтый. Он не будет ярким, так как но-
вообразованный цвет не может быть
светлее своих родителей.

Давайте наложим зеленый слой с
прозрачностью 50% поверх красного —
сначала в RGB, потом в LAB. Photoshop
идет по простому, но нежелательному
для нас пути, усредняя оба цвета. Когда
внизу находится максимально яркий
красный, 255R 0G 0B, а вверху макси-
мально яркий зеленый, 0R 255G 0B,

Photoshop предлагает усредненный
цвет 128R 128G 0B, вызывающий изряд-
ное разочарование.

Теперь преобразуем те же цвета в
LAB и посмотрим, что даст усреднение
там. Красный превращается в 54L 81A

70B, а зеленый — в 88L (79)A 81B. Усред-
ненный цвет 71L 1A 75B значительно от-
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Размытие раньше, резкость позже
Размытие и повышение резкости — это
две стороны одной «шумной» медали.

Увеличьте цифровое изображение, и
вы увидите артефакты или шум:  посто-
ронние пикселы, нарушающие однород-
ность картины.

В умеренных количествах шум поле-
зен. С помощью команды Edit > Fill мы
можем создать идеально ровное синее
небо. Но оно будет выглядеть синтетиче-
ским в отличие от реальной фотографии,
где привнесенный камерой шум придает
небу аутентичность.  Повышение резко-
сти тоже основано на контролируемом
добавлении шумов, которые помогают
подчеркнуть границы между областями
разных цветов.

Когда шума слишком много, это пло-
хо: изображение становится грубым,
рваным и неестественным. При этом до-
вольно трудно определить, что значит
«шума слишком много». Нередко одно и
то же изображение одновременно нуж-
дается и в размытии, и в повышении рез-
кости. 

Эти операции следует выполнять на
разных стадиях процесса. Если изображе-
ние требует обширной коррекции, то
размыть его лучше сразу, иначе последу-
ющая коррекция усилит шум, устранить
который будет уже труднее.

По той же самой причине повышение
резкости следует откладывать до послед-
него, иначе последующая коррекция мо-
жет усилить ореолы настолько, что те бу-
дут портить изображение.



личается от того, что было в RGB, и
выглядит гораздо лучше. Цвет 128R

128G 0B переводится в LAB как 52L

(9)A 56B, который одновременно яв-
ляется слишком нейтральным, слиш-
ком зеленым, а главное слишком
темным. Если результат LAB-усред-
нения перевести обратно в RGB, мы
получим более светлый цвет — 201R

171G 0B. Отметим для CMYK-шови-
нистов: наш LAB-результат перево-
дится в CMYK как 24C 27M 100Y 1K, а
RGB-метод дает мутный и грязный
51C 36M 100Y 13K.

Что за безобразие? Почему нало-
жение в RGB образует цвет, который
оказывается не только слишком се-
ро-зеленым, но еще и таким темным?

Тому есть две причины. Во-пер-
вых, усреднение цветов в RGB — пря-
мой путь к их посерению, поскольку
цвета здесь получаются более нейт-
ральными по сравнению с LAB-верси-
ей. Но самое главное — это установка
гаммы. При шкале от 0 до 255 отмет-
ка 128 находится, казалось бы, посе-
редине, но в действительности она
смещена и передает более темный
тон. Поэтому трюк со сложением
двух каналов и делением получивше-
гося значения 255R 255G 0B пополам
не дает ожидаемых результатов. К то-
му же Photoshop усиливает зеленый
компонент смешанного цвета, отчего
его значение в канале А оказалось на
10 пунктов меньше по сравнению с
вариантом, полученным в LAB.
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Рис. 5.16. Благодаря более совершенному мето-
ду усреднения, LAB смешивает цвета аккурат-
нее, чем RGB. В каждой из версий три верти-
кальные полосы чистых красного, зеленого и си-
него цветов с прозрачностью 50% были наложе-
ны на три горизонтальные полосы тех же цве-
тов. Вверху: результат наложения в LAB. Посе-
редине: результат наложения в RGB с нормаль-
ной гаммой. Внизу: результат наложения в RGB
с гаммой 1.0 и включенным режимом компенса-
ции, как показано на рис. 5.17.



Пара примеров с машинной графи-
кой поможет прояснить преимущество,
которое демонстрирует LAB при сме-
шении цветов. Следует иметь в виду,
что оно распространяется на все виды
ретуши, а не только на размытие. До
сих пор у нас не было повода для сме-
шения цветов, но в профессиональной
ретуши этим приходится заниматься
постоянно, а в LAB оно всегда дает луч-
шие результаты.

Давайте расширим нашу задачу
смешения красного и зеленого цветов,
дополнив их еще и чистым синим.
Возьмем слой с тремя вертикальными
полосами 50% прозрачности и нало-
жим его на слой с тремя такими же го-
ризонтальными полосами. Пока это не
имеет отношения к размытию, но по-
терпите немного.

На рис. 5.16А эти два слоя показаны
в LAB, а на рис. 5.16В — они же в RGB.
Соответственно усреднение выполнено
двумя разными методами. Как видите,
все образованные в результате наложе-
ния квадраты на рис. 5.16В слишком
темные — и к тому же не тех цветов.

Вариант на рис. 5.16В настолько
плох, что Photoshop предлагает воз-
можность его частичного исправле-
ния. Нажав кнопку More Options
(Photoshop CS2) или Advanced Mode
(Photoshop 6-CS) в диалоговом окне
Color Settings, вы сделаете доступным
параметр, показанный на рис. 5.17.
Когда он включен, в процесс наложе-
ния слоев вводится поправка с учетом
особенности гаммы RGB, чтобы не до-
пустить излишнего затемнения цветов,
как это было до сих пор. С этим режи-
мом компенсации мы вместо версии
5.16В получаем версию 5.16С.

Она уже лучше. Но поскольку в ней
слишком много зеленого, она все
равно уступает версии 5.16А. При
оценке результата следует исходить из
того, что все цвета должны сохранять

равномерность тона. Средняя гори-
зонтальная зеленая полоса на рис.
5.16С смотрится хорошо, а  вертикаль-
ные красная и синяя выглядят так, буд-
то кто-то выгрыз у них середину.

Но сколь бы ни был интересен наш
эксперимент с гаммой 1.0, это актуаль-
но только для наложения цветов. Что
касается размытия и других вещей, бо-
лее близких к нашей тематике, то там
гамма никак не влияет на результат. Из
этого вытекает громадное преимущест-
во LAB, связанное с размытием цвет-
ных шумов, что и подтверждается сле-
дующим примером.

Снова возьмем картинку с цветными
квадратами и попробуем немного сгла-
дить различия между ними, не разру-
шая самого изображения. Рис. 5.18А
содержит только вариации цвета, свет-
лота которого повсюду одинакова и со-
ставляет 65L.

Версия 5.18В получена в LAB в ре-
зультате применения фильтра Gaussian
Blur с радиусом 20.0 к каналам АВ.
(Разрешение картинки составляло 140
пикселов на дюйм.)

Версия 5.18С выглядит как ложная
цель на экране радара — вроде и есть
какая-то информация, но она ничего не
значит. В данном случае копия ориги-
нала была преобразована в RGB, поме-
щена на новый слой и размыта с той же
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Рис. 5.17. В диалоговом окне Color Settings есть функция,
помогающая избежать проблем, которыми страдает
версия 5.16В. (Она становится доступной, если выбрать
More Options или Advanced Mode.)  Программа автомати-
чески делает поправку на гамму RGB-пространства, в ко-
тором работает пользователь, отображая цвета с боль-
шей точностью.



установкой Radius 20.0. Картинка пре-
тендовала на соперничество с LAB-вер-
сией, но она была снята с соревнований
перед началом забега. 

Размытие каналов АВ открывает пе-
ред нами широкие возможности, но
при этом нельзя размывать канал L —
если только мы не хотим специально
смазать детали. В RGB тоже нельзя
просто так размывать каналы: посколь-
ку они содержат информацию о цвете
и контрасте, то размытым окажется не
только шум, но и все изображение.

В своем нынешнем виде версия
5.18С непригодна к использованию.
Восстановить в ней детали нам помо-
жет режим наложения Color, противо-
положный Luminosity. Когда верхнему
слою документа мы задаем режим

Luminosity, детали берутся с верхнего
слоя, а цвет — с нижнего. В режиме
Color происходит обратное: цветовая
информация берется с верхнего слоя и
накладывается на детали нижнего. Те
же результаты, хотя и с меньшей свобо-
дой маневра, дает и другой, более про-
стой прием, предполагающий примене-
ние команды Edit > Fade > Color сразу
после размытия, которая позволяет
ослабить эффект.

В обоих случаях мы получаем версию
5.18D. Так как изначально перед нами
ставилась задача нивелировать цвето-
вые вариации, следует признать, что эта
версия лучше оригинала. Но, сравнивая
ее с LAB-версией, следует признать, что
они находятся в совершенно разных «ве-
совых категориях».
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Рис. 5.18. Размытие каналов АВ в LAB дает лучший результат, чем метод RGB/Color. Вверху слева: оригинал. Ввер-
ху справа: результат применения фильтра Gaussian Blur с радиусом 20 пикселов к каналам АВ. Внизу слева: версия,
полученная простым размытием в RGB, отличается от LAB-версии. В RGB пострадали детали и цвет, тогда как
размытие АВ не повлияло на канал L. Сравните оригинал с вариантом внизу справа, который представляет собой
RGB-версию, ослабленную в режиме наложения Color.



Результат размытия АВ
всегда лучше того, что дает
метод RGB/Color. Но, так же
как при повышении резкости
в канале L и методом RGB/
Luminosity, это преимущест-
во иногда может казаться
незначительным. Однако в
отличие от повышения рез-
кости, которое обычно вы-
полняется под конец коррек-
ции, размытие, как правило,
делается в самом ее начале.
Если шумы не размыть сразу,
то потом они лишь усилятся.

Компьютерная графика,
вроде картинок на рис. 5.16
и 5.18, хороша для нагляд-
ности, но поскольку мы ра-
ботаем преимущественно с
фотографиями, обратимся
под занавес к реальному
изображению с огромным
количеством шумов. В свое
время мне пришлось коррек-
тировать его для пуб-
ликации, и оно наверняка
знакомо читателям моей
журнальной колонки Make-
ready и книги «Photoshop для
профессионалов».

Версия на рис. 5.19С,
размытая методом RGB/
Color, представляет собой
явный прогресс по сравне-
нию с совершенно ужасным
оригиналом. Но она гораз-
до хуже версии 5.19В, где
были размыты каналы АВ.
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Рис. 5.19. На примере этой фото-
графии с невероятным количеством
шумов продемонстрировано преиму-
щество размытия каналов АВ (посе-
редине). Метод RGB/Color (нижняя
версия) плохо справляется с красно-
зеленым шумом.
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Здесь следует отметить два важных
момента.

Во-первых, в версии 5.19С заметнее
пятна на фоне. Программа пыталась
растворить красный шум в зеленой об-
ласти, что (как и в примерах на рис.
5.16В и 5.18D) обречено на провал, по-
скольку в RGB смешанные цвета полу-
чаются слишком темными и слишком
зелеными.

Во-вторых, мнимые цвета LAB-файла
пошли на пользу версии 5.19В, дав тот
же сглаживающий эффект, который мы

наблюдали, например, в изображении с
желтым плакатом на рис. 5.11. Это осо-
бенно благотворно сказалось на лице:
если в RGB-версии полно черных точек,
то в LAB-версии оно практически чис-
тое. Изначально эти точки показывали
0L и 0А 0B. Размытие АВ, не затрагиваю-
щее канала L, дало в результате нечто
близкое к 0L 50A 50B, а это типичный во-
ображаемый цвет: ярко-красный и в то
же время угольно-черный. В ходе пре-
образования в другое цветовое прост-
ранство Photoshop старался хоть как-то
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Рис. 5.20. Разные дефекты требуют разных методов лече-
ния. Родство между красным каналом RGB (вверху слева) и
каналом А из LAB (в центре справа) вполне очевидно. Эти
зубчатые линии слишком велики для фильтров Gaussian Blur
и Surface Blur, поэтому лучше обратиться к Dust & Scratches.
Зеленый и синий каналы RGB (в центре слева и внизу слева)
содержат шумы, близкие к шумам в канале В (внизу справа).
Для размытия этих трех каналов вполне достаточно
фильтра Gaussian Blur.



сохранить красный оттенок, но смог
лишь осветлить его — а именно это нам
и надо.

Кроме того, исчезли пустые белые
пятна на лице. Если в RGB и CMYK са-
мые светлые области должны быть бе-
лыми, то в LAB это вовсе необязательно.

Поскольку шум в разных каналах
имел различный характер, я воспользо-
вался двумя разными методами для его
подавления. Зубчатую структуру в
красном канале и канале А на рис. 5.20
невозможно было аккуратно размыть
такими фильтрами, как Gaussian Blur
или Surface Blur, поэтому я применил к
ним Dust & Scratches с радиусом 15 пик-
селов, а остальные три канала размыл
фильтром Gaussian Blur с радиусом 8.0.
Разрешение изображения на рис. 5.19
составляло 72 пиксела на дюйм.

Актуальность размытия
в цифровую эру

В наши дни, в эпоху цифровых камер и
низкокачественных оригиналов, про-
блема размытия становится все острее.
Раньше, когда все снимали на фото-
пленку, мы имели дело с зернистыми
оригиналами, так что к шумам нам не
привыкать. Но цветовой шум с мало ме-
няющейся базовой яркостью — это уже
новое изобретение, которое ставит в
тупик большинство пользователей. 

Вот лишь несколько типов изобра-
жений с врожденными шумовыми де-
фектами, для лечения которых требует-
ся хирургическое вмешательство в АВ:
● Снимки, сделанные в условиях сла-
бой освещенности.
● Спортивная фотография и вообще
съемка быстрого движения, требую-
щая малой выдержки.
● Подводная съемка. Когда в изобра-
жении доминирует один цвет (в дан-
ном случае синий), велика вероятность
образования цветового шума.

● Изображения с высокой степенью
компрессии, способной ухудшить каче-
ство репродуцирования. Популярный
алгоритм сжатия JPEG склонен жертво-
вать скорее цветом, нежели деталями,
отчего в каналах RGB могут появляться
артефакты в виде больших квадратов.
Но если JPEG-файл перевести в LAB, то
эти артефакты перекочуют в каналы
АВ, где от них можно легко избавиться.
● Старые оригиналы с видавшей виды
эмульсией.
● Многие современные цифровые ка-
меры образуют заметную цветную кай-
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Заключение
Повышение резкости в канале L и
размытие каналов А и В придают осо-
бую привлекательность работе в LAB.

Иногда повышение резкости в L
дает лучший эффект, чем в RGB или в
CMYK, особенно если в изображе-
нии есть светлые и одновременно
красочные объекты или когда наи-
более важные объекты являются
темными.

Размытие каналов АВ дает лучший
результат, чем метод RGB/Color или
размытие в RGB с гаммой 1.0. Метод,
используемый для смешения цветов
в LAB более совершенен, и изобра-
жение выглядит естественнее. Се-
годня все чаще приходится работать
с цифровыми фотографиями, со-
держащими большое количество
цветовых шумов, для устранения ко-
торых лучше всего использовать
размытие АВ.

Резкость следует повышать в кон-
це коррекции. Если изображение
нуждается в размытии, то делать это
лучше на ранней стадии процесса.



му на стыках областей разных цветов —
явление, известное как хроматическая
аберрация. Дополнительный модуль
Photoshop Camera Raw предлагает воз-
можность устранения этого дефекта
(если, конечно, вам посчастливится
иметь камеру, которая поддерживается
Camera Raw), но обращение к каналам
АВ помогает решить эту проблему бо-
лее элегантно.
● Изображения с недостаточным раз-
решением. Сегодня не всегда можно
сказать точно и определенно, какое раз-
решение является достаточным. Навер-
ное, поэтому не переводятся простаки,
которые настойчиво предлагают нам за-
грузить из Интернета JPEG-файл объе-
мом 128 Кбайт и напечатать его в жур-
нале во всю страницу. Если файл имеет
недостаточное разрешение, печатная
картинка получится зернистой, зазуб-
ренной и будет вся в пятнах, напомина-
ющих квадраты на рис. 5.18, если их
своевременно не размыть в каналах АВ.
● А самая большая беда — это растри-
рованные оригиналы. Изображения, на-
печатанные на бумаге, состоят не из

сплошных цветовых областей, а из на-
кладывающихся друг на друга решеток
голубых, пурпурных, желтых и черных
точек. Это самый настоящий цветовой
шум, который не очень-то поддается ле-
чению, потому что в нем содержится и
контраст изображения. Если с этим шу-
мом ничего не делать, в перепечатанном
изображении появится муар, а если его
размыть в RGB, пропадут детали. Пере-
вод файла в LAB и размытие каналов АВ
поможет убрать значительную часть
проблемы. В главе 11 этот процесс бу-
дет рассмотрен более подробно.

Все это позволяет заключить, что
совсем недолго осталось до запуска
нового стиля ретуши — отсчет времени
уже пошел. Если для исправления мел-
ких недостатков вам достаточно инст-
румента «штамп» или «восстанавливаю-
щая кисть», то совершенно неважно,
где вы будете работать — в RGB или в
CMYK. Любая более сложная коррек-
ция предполагает смешение двух цве-
тов. И мы теперь знаем, какое цветовое
пространство в наш космический век
лучше приспособлено для этого.
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